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Section A -- General Use 
 
Lesson 1 – Basic Map Functions 
  

1.7. Map Navigation Tools 
o Zooming In or Out  – When working with a map it may be necessary to 

zoom in to view an area in more detail, or zoom out to see a larger area. 
 
STEPS FOR ZOOMING IN 

0. Click the Zoom in button  on the Tools toolbar. 
0. Move the mouse over the map. 

 . Single click to zoom in around a point.  
OR If you wish to zoom to a specific area   

 . Click and hold the left mouse button, drag a box around 
the area that you wish to zoom in to, release the button 
to complete the zoom. 

 
STEPS FOR ZOOMING OUT 
  

0. Click the Zoom out button  on the Tools toolbar. 
0. Move the mouse over the map. 

 . Single click to zoom out around a point 
OR If you wish to zoom out to a specific area   

 . Click and hold the left mouse button, move the mouse to 
drag a rectangle to create the area. The current map 
extent will be resized to fit in the rectangle you draw. As 
a result the smaller the rectangle the further you will 
zoom out.  Release the mouse button to complete the 
zoom.  

 
ALTERNATE STEPS FOR ZOOMING IN OR OUT 
  

0. Click the fixed zoom in  or fixed zoom out  on the Tools 
toolbar.  This will zoom in or out a fixed amount around the 
current center of the map. 
 

         ZOOM TO FULL EXTENT 

0. Click the zoom to extent button   on the Tools toolbar.  This  
will zoom to the full extent of all the layers in the map view. 

    
         ZOOMING TO PREVIOUS/NEXT EXTENT 

0. Zooming to previous or next extent allows stepping back and 
     forth through past map views. For example, start with a map  

 view at full extent then zoom in to an area on the map. Now click  

 the previous extent button ; the map will return to the most 
 recent previous map view, which was the full extent. Now click 

 on the next extent button ; the map will return next to the 
 extent originally zoomed to, from the full extent. 

 
           



 

 

        PANNING 
1. Panning allows you to move the map display around to show 

areas outside of the current viewing area without changing the  
scale of the map.   

To pan the map, click the Pan button  , on the tools  
toolbar.  Move the mouse over the map, click and hold down 
the left mouse button.  Move the mouse, still holding the mouse 
button down, the map will move with the mouse.  Release the 
mouse button to complete the pan.   

  
1.2.       Using the Legend 

o The legend is a graphical representation of all the map layers in the 
current map view.  The default position of the legend is docked on the 
left hand side of the screen.  In the Dispatch mode of AccuGlobe E911, 
the legend offers the ability to turn the layers on or off and the ability to 
change the vertical order of the layer in the redraw process. 

 
 
 

·  To turn the legend off, left-click on the X in the 
top right corner of the legend box.  This will make 
the legend disappear 

 
·  To turn the legend back on, Select Legend  from 

the View pulldown menu. 
 

·  Setting the Active Layer – The active layer, is 
the layer that is designated as active by having a 
black background behind the name in the legend.  
Being the active layer allows the features on that 
layer to be Identified or searched on. 

                   You can select the active layer by clicking on the 
                   name of that layer in the legend. 

 
·  To move a layer’s position in the legend, left-click 

and hold on the layer name.  While holding the 
mouse button down, drag the layer either up or 
down in the legend box.  Moving a layer’s 
position also changes that layer’s order in the 
map redraw process.  

 
·  You can expand the individual legends for each 

layer by clicking on the + or – that represents 
each layer. 

 
·  If a layer is not currently set as scale dependent 

you can turn the layer on or off.  If the box next to 
the layer name is not colored gray, then you can 
toggle that layer on and off, by clicking on that 
box. 

 
 
                        
 

              



 

 

 
 

1.3.      Identifying a Feature on the Map  
o Identifying a feature on the map will bring up the Identify Results box 

containing all of the attribute information for the point being identified.  
This information can then be scrolled through.  By default the tool will 
only identify features on the active layer. 

0. To identify a feature on the map, first make sure that the 
active layer contains the point that is going to be identified. 

0. Click on the Identify  button on the tools toolbar.  Move 
       the mouse over the map and click on the feature that is to be 
       identified. 
 
0. You can select different selection criteria from the pull-down 
       list in the Identify Results box.  You can change from the 
       active layer to other selection criteria and select other 
       features with the results box open.   
   

     1.4.       Using the Map Magnifier 
o The map magnifier opens a new window that shows the same map as 

the main map view, only in more detail. The degree of magnification can 
be set from 50% (which actually shows less detail) to 1000%. 

1. To use the magnifier, click the Map Magnifier tool , on 
       the main toolbar. 

o To change the magnification factor do the following 
0. Open the magnifier window as shown above.   
0. Click the mouse anywhere inside the map magnifier 

window, an input box will pop up prompting you for a new 
magnification factor. 

0. Enter the value and click ok. 
 
   1.5.      Measuring Distances and Areas 

o There are two measuring tools in AccuGlobe E911.  The map units of the 
view must be set in order to use these tools.  To set the map units, click 
on Properties  under the View pull-down menu, then set the map units 
from the pull-down menu. 

  The line measuring tool will measure the length of a user defined line. 

0. Click the measure tool on the Tools toolbar. 
0. Move the mouse over the map to the starting position. 
0. Using the left mouse button click once and now move to 

the next position. A line will draw as the mouse is moved. 
0. Using the left mouse button, double-click to end the 

distance measurement at that point or single-click and 
continue to move the mouse to the desired end point, and 
then double-click.  The distance will then be calculated and 
displayed in a pop-up window. 

  The area measuring tool calculates the area of a user defined polygon.  

0. Click the area measure tool  on the Tools toolbar. 
0. Move the mouse over the map to the starting position. 
0. Using the left mouse button click once and now move to 

the next position. A line will draw as the mouse is moved. 



 

 

0. Using the left mouse button, click once to define the next 
point in the polygon. 

0. Repeat steps 3 and 4 to create the desired polygon. 
0. Complete the measurement by double clicking instead of 

single clicking for the final point with the left mouse button. 
The area will be calculate and displayed in a pop-up 
window. 

 
0.5. Displaying a Hyperlinked image or document 

o Hyperlinks provide a way to link external data to a feature on the map. 
For example, by having a map layer that contains points for cities it is 
possible for one of the data attributes to point to the name of an external 
image file that contains a photograph. A hyperlink could be enabled to 
show the image of the city when clicking on said feature on the map. 
Hyperlinks are not limited to images. They can contain websites, word 
processing documents, spreadsheets or any other file.  These links (if 
available) will be already set up in AccuGlobe.   

 To use the Hyperlink tool. 

0. Click the Hyperlink tool  on the Tools toolbar. 
0. Move the mouse over a feature on the map and click on it. The 

hyperlinked document will be displayed. (If the Hyperlink is available) 

0.5. Using the Overview Map 
o The Overview Map is opened by default when you open AccuGlobe 

E911 .  The overview map shows where the area on a county wide map 
that is being shown in the main map window.  The overview will display 
the area inside a red box. 

 
 

·  You can close the Overview 
Map by clicking on the X in 
the top right corner of the 
map. 

·  To open the overview map 
after it has been closed, 
click on the Overview Map 

Toggle Button.  
·  You can also navigate with 

the overview map by 
clicking on an area in the 
overview map and the main 
map window will zoom to 
that area. 

 
 
 
 
 
 
 
 



 

 

Lesson 2 -- AccuGlobe Data Explorer Functions 

  2.1.    Searching 

o There are three buttons on the toolbar that will get the user to the 
searching options 

o The main search button, , will open up four search options.  It 
has one main search/query builder, and three customized searches;  
Parcel Search, Owner Search, and Address Search. 

           

0. The Standard Search Tab has a query builder that you can use 
to query on multiple fields in the database and/or shapefiles.  
You can also create complex queries and save them to the disk, 
to be used later. 

 
      

 
 
- Results of any search done with the main search button, will be displayed in the Search Results 
area at the bottom of the display, with the number of records returned displayed on the tab. 
 
- The results area can be sorted by clicking on the column names 
 
- The user can select any one of the results by clicking on that record, by doing this, the map will 
automatically zoom to that parcel. 
 
-  By double-clicking on a record, the user can access the Edit Notes for that parcel.  They can 
read any existing Edit Notes, or add new notes that will be saved in a database. 



 

 

 

              
   

0. The Parcel Search Tab is the first of the customized searches 
that are available from the main search button.  To use the 
parcel search, enter a parcel number in to the above search, and 
click search.  The results will be displayed in the Search Results. 

 
 

 
 

0. The Owner Search Tab can be used to search the parcels using 
the owner’s last name and first initial.  It is best only to use the 
first initial rather than the whole first name.  The results for the 
Owner Search will be displayed in the Search Results. 

 
 
 
 



 

 

        
   

0. The Address Search Tab can be used to search the parcels 
using the address of the property address of the parcel.  To get 
the best results it is best to search only using house number and 
street name.  You should try not to search using street types 
(AVE, BLVD,ST, etc). 

 

The other available search button is the Geographic Search (Latitude/Longitude Search).    
 
-  The Geographic Search Tool  allows the user to do a   search using latitude and longitude 
coordinates.  The coordinates can be entered in Decimal Degrees or Degrees, minutes, seconds. 
-  Enter the coordinates into the boxes and click on Query.  The map will the map will 
automatically zoom   to the location. 
-  Remember that in the United States, the Longitude coordinate should be a negative number. 
 

 
 
 
 
 



 

 

The final available search tool is the Road Search (Road/Address/Intersection Search)  
 

- The Road Search allows the user to search the datasets for either a road, 
address, or road intersection. 

-  This search can only be used when the map data is of the quality where geocoding is available 
and set up by an administrator using the Configuration Wizard. 
-  By clicking on the Road Search button seen above, you can open up the Road Search dialog 
and begin your search. 
 

 

 
 

o To use the Street Search start by entering the part of the name in the  
“Look For:” box.  As you type in the name, the “Street List” will begin 
to populate as you type more letters in. 

 
o Once the “Street List” is populated, click on the street name that you are looking 

for.  Doing this will populate the two lower lists if that information is available. 
 

o The middle list is the address points that match the street name that you are 
searching on.  The lower list is the streets that intersect the matching street name 
that you searched on.  You can click on a record on either list and the map will 
instantly zoom to that spot.   

 
                              
 
 
 
              



 

 

11.3. Selecting on the Active Layer 
o Another way to get the information about a parcel is to use the map 

navigation tools to find the parcel that you are looking for, and use one of 
the selection tools to manually select that parcel. 

                                                 

    
 

o You can use one of the above tools to select a parcel on the map.  To 
activate the tools, left-click on any one of the five selection tools on the 
left end of the menu. 

  Select by Point :  This tool allows you to select a feature on the map by  
clicking a single point. Any features of the active layer that fall within the 
selection tolerance will be selected. 

       Select by Line :  This tool allows you to select features on the map by 
drawing a line.  Left-click a point on the map to start the line.  Move the 
mouse to another location; single-click to add another point to the line, or 
double-click to finish the line. Any features of the active layer that fall 
within the selection tolerance of the line will be selected. 

       Select by Rectangle :  This tool allows you to select features on the map  
by drawing a rectangle. Left-click and hold while the cursor is over the 
map. This click will represent the first corner of the rectangle.  Move the 
mouse to another location, keeping the left mouse button held down.  
Release the mouse button to specify the opposite corner of the 
rectangle.  The height and width of the rectangle will display in the status 
bar at the bottom of the screen. Any features of the active layer that fall 
within the selection tolerance of the rectangle will be selected. 

       Select by Circle :  This tool allows you to select features on the map by 
drawing a circle.  Left-click and hold while the cursor is over the map.  
This click will represent the center of the circle.  Move the mouse button 
away from the established center to expand the circle.  Release the 
mouse button to specify the size of the circle.  The radius of the circle will 
display in the status bar at the bottom of the screen.  Any features of the 
active layer that fall within the selection tolerance of the circle will be 
selected. 

       Select by Polygon :  This tool allows you to select features on the map by 
drawing a polygon.  Left-click the mouse over the map to represent the  
first point of the polygon.  Move the mouse and click again to select the 
second point.  Repeat this step as many times as required.  To close the 
polygon, double-click the mouse.  A line then be drawn from the location 
you double-click to the first point that was dropped, in order to close the 
polygon.  Any features of the active layer that fall within the selection 
tolerance of the circle will be selected. 
 
Selected parcels will be displayed in the Search Results box at the 
bottom of the display.  Single-clicking on a record will select it.   



 

 

  
  

1.2     Viewing Tax Information 
o Once you have the parcels selected that you are looking for, you can click on 

the record that you want to see the information for.  The map will 
automatically, re-center on that parcel, and you can now select which data 
screen you would like to view. 

 

 
   

o The Screens toolbar (above) will only be visible while parcels are the active 
layer.  When it is active and you have a parcel selected, you can click on any 
one of the screen names that are available on the toolbar.  Every county will 
have different screen names and a different number of screens. 

 
o Single Click on any of the screen buttons and the map will be replaced by the 

data screen. 
 
 

 
 
 
 
 
 
 
 
 
 



 

 

 2.4 Buffer Tools  
o There are two types of buffer tools built into Data Explorer.  The quick 

buffer and the advanced buffer 
 

o The Quick Buffer    is available to use 
directly from the main toolbar area. 

-  The Quick Buffer will select every feature on the selected layer 
within the designated distance of the already selected feature.   

    -  The newly selected features that are selected within the buffer  
    are now displayed in the Search Results area. 
 
 

 
   

-  The selected features can be sorted and analyzed using the 
Search Results controls and can be exported using the Export 
tools that will be discussed later. 
 
 
 
 

 



 

 

 
o The Advanced Buffer is located in the Tools pull-down menu. 

 

 
 

 -  Once the Advanced Buffer is selected from the tools menu it will bring  
 up the buffer wizard. 
 

 
Buffer Wizard 

                         
 

1. Select whether you want to buffer against all the features on the active layer or only 
against the selected features of the active layer.  If you select all the features, it may 
take a large amount of time to complete the selection (up to 5 minutes depending on 
the amount of features in the shapefile).  Click next. 

 

                                
 

1. The second step allows you to select the type of buffer. 
 . Single Buffer  – similar to the quick buffer, with changeable distance (map 

units) 
 . Single Buffer with an Attribute specified Distance  – buffer distance 

specified by numeric field in the shapefile attribute table 



 

 

 . Multiple Concentric Ring Buffer   (grayed out above) – can only be used 
with a point based layer;  this will create a ring buffer graphic with multi 
colored rings with each ring representing a user specified distance.  The user 
can then use the circle selection tool to select all the points within the circular 
buffer. 

 

    
 

     

   
 

1. The last step allows you to choose what you want to do with the buffer.  You can  
choose what shapefile in the project that you want to do a buffer selection within the 
specified distance.  You can select on any layer within the project.  The selected 
features will be displayed in the Search Results box. 

 
 
 
 
 



 

 

1.1  Data Export 
o When data is selected or queried the list of selected features are displayed in 

the Search Results.  Once features are selected, there are three different 
ways to export the data to other file formats. 

   
 
 
 
 

1. Export map view as a bitmap – from the File 
menu, select “Export Map As…”.  This will create 
a .bmp image based on what is in the map view 
at the time. 

 
 
 
 
 
 

 
 
 
 
 

         
 

a. Export Data as Text File  – from the File menu, select “Export Data As…”.  This 
will bring up the above wizard to create a comma delimited text file.  You can 
customize the file by add/selecting which fields that you want in the file and the 
order that you want them displayed.  The wizard gives you the option to view the 
data immediately in the associated application, trim white space out of the file, 
and where to save and what to name the file. 

 
 
 
 



 

 

 
 
 
 

2. Export Selected data as Shapefile – This option 
is not available when Data Explorer is in public 
mode.  The restrictions associated with Public 
Mode, limit the public user’s ability to right-click on 
the legend.  To access this option, right-click on 
the active layer, and select the Export option.  This 
will bring up a wizard to accomplish the export. 
(see below) 

 
 
 
 
 

 
                                                                                              

 
 
-   Use this wizard to export the      
data as a new shapefile.  You can 
export all the features in the 
shapefile or export just the selected 
features. 

 
 

 
1.2 Print via Template 

o The public user has the ability to print a map via a template that is created by 
the county and saved locally on the computer.  In order to print the map with 
any specific details other than just the map (north arrow, title, etc), the 
easiest way is to use a template. 

 
 
 
 
 
-  Select “Print Via Template” from the File pull-down 
menu.  
 
 
 
 
 
 
 

 
o This will bring up the template selection screen, and prompt the user to 

select the template that they wish to print with.  Once they select a template, 
the print screen will pop up with the selected template in place. 
 



 

 

Section B – Administrator Guide 
 
Lesson 1 – Configuration Wizard 
  

1.0 Locating the Configuration Wizard 
 

o To get to the Configuration wizard, while not in Public mode, left-click the 
Tools pull down, and select “Configuration Wizard”. 

 

 
 
 

1.0 Using the Configuration Wizard  
 
o The Configuration Wizard consists of seven different screens with different 

choices and options for the configuration of AccuGlobe Data Explorer.  By 
clicking on the “Next” button after you have confirmed your selections, you 
can move on to the next screen.  Once you have moved beyond the first 
screen you will have the option to use the “Previous” button to move back 
and revise your choices.  The last screen will not have a “Next” button, just 
click “Close” to confirm your changes. 

 
o When finishing using the configuration wizard, AccuGlobe will remind you 

that some changes will not take effect until AccuGlobe is restarted.  It is best 
to restart AccuGlobe anytime you have made any changes using the 
Configuration Wizard. 

 
 

                        
 
 



 

 

Configuration Wizard Screen 1 – Project Settings  
 

 
 
 
 



 

 

Configuration Wizard Screen 2 – Edit Notes  
 

 
 



 

 

Configuration Wizard Screen 3 – Database Connection s 
 

 
 



 

 

Configuration Wizard Screen 4 – Display Fields  
These Display Fields are displayed in the Search Results box at the bottom of the 
program. 

 

 
 



 

 

Configuration Wizard Screen 5 – Custom Screen Datab ase References  
 These are the databases used to get the data for the information screens. 
 

 
 



 

 

Configuration Wizard Screen 6 – Exporting Data  
 This customizes and configures the “Export Data As…” tool. 
 

 
 



 

 

Configuration Wizard Screen 7 – Quickview Comboboxe s 
 This screen lets the administrator configure Quickview comboboxes that appear under 
the Search Results box and allow the user to quickly zoom to specified areas.   
 

 
 

 
 
 
 
 
 



 

 

Configuration Wizard Screen 8 – Public Mode Options  
 This screen lets you control what mode Data Explorer operates in. 
 

 
 
 
Data Explorer Public Operation Modes 

 
o Normal – Full Data Explorer functionality, with the ability to add/remove layers, edit 

layers, and change the way features are displayed, can only be changed back to this 
from one of the below, is to manually edit the config file. 

 
o Low  – More limited functionality to prevent changes to data or display 

-  No right-click on legend 
-  Limited pull-down menus 
-  No ability to move layers in legend 
-  No ability to add/remove layers 
-  Not able to change display options for features 
-  Can not save project 
-  No access to configuration wizard 

 
o Medium   

-  Locks toolbars, Search Results, and Legend 
 

o High  
-  Locks overview map 
-  Hides identify tool 
 
 



 

 

Configuration Wizard Screen 9 – Geocoding/Road Sear ch Setup  
 This screen allows the administrator to set up the layers and fields that will be used for 
geocoding.  The geocoding is important so that the Road Search will function. 
 
 

 
 

o This dialog allows the administrator to pick the Address layer and Centerline layer that 
are available in the Data Explorer, then chooses the appropriate fields within those 
shapefiles to use for geocoding. 

o At the bottom left of the dialog you can choose what colors are used for the results of the 
Road Search. 

o The bottom right of the dialog allows the administrator to build or re-build the geocoding 
indexes.  These are not built by default and must be built before the Road Search will 
function.   

o It must be noted that use of this feature depends heavily on the structure and quality of 
the GIS data.   

o An address point layer is absolutely necessary for this feature, and it will not 
function without one. 

o The road centerline layer must have address ranges. 
o Both the addresses and centerlines must at least have all of the fields in the 

dialog that are not listed as optional fields.  The optional fields are labeled with an 
asterisk (*). 

  
  



 

 

 
1.0 Config File  

 
o The Configuration wizard is a user friendly way to edit a file that controls the way 

the program functions and displays things, that file is called the config.ini file. 
 

o There may be a time when the Administrator will need to manually change the 
config file, below you can see a screen shot of a sample config file with some 
explanation of the different parts of the config.ini file. 

 



 

 

 


